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Chapter 1

Introduction

There are many tools to measure the Strehl ratio yet. Why a new one ?
ABISM claims to be the most user friendly Strehl meter, no configuration is needed:

• The 4 needed parameters (wavelength, pixel scale, diameter and obstruction) are
read out from the fits header.

• The apertures for background, photometry is automatically assessed from a fit.

• Correction is made for bad pixels1.

• Some labels and check plots are displayed for the user to estimate the validity of
the result.

ABISM is a GUI written in Python.

1.1 What is the Strehl ratio ?

The Strehl ratio (here after SR) is defined as the peak intensity of a measured PSF
to the peak intensity of a perfect diffraction limited PSF for the same optical system
(aperture + obstruction):

Sr =
I(x = 0)

P (x = 0)
(1.1)

Where x stands for the position vector on the image on a PSF centred on 0; I(x =
0) for the maximum intensity of the measured PSF and P(x = 0) for the maximum of
the perfect diffraction limited PSF. In Figure 1.1, it’s the ratio between the maximum
of left curve and the maximum right curve.

1..in the background, not implemented yet in the photometry where the deviation from the fit should
be the criterium of the badness of a pixel
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1.2 What ABISM does ?
A fit (Moffat by default) is performed over the selected area. The peak of the PSF is
measured by the fit. An elliptical aperture is also deduced from the fit in order to get
99% of the flux2. The photometry is performed in this aperture and the background
is computed in an annulus between 1.3 and 1.6 times the photometric aperture and
with a 3 sigma kappa clipping. From the photometry, peak, wavelength, pixel scale,
diameter of the primary mirror, and the central obstruction, the Strehl is calculated.
No Fourier transform is performed, but an analytical expression3 links the photometric
of the object to the peak it would have in a diffraction limited system.

1.2.1 What you have to do
• Open ABISM (bash Abism.sh [image.fits] or >python Abism.py [image.fits] [params]

• Open ONE image.fits in command line following the script or from the GUI:file→open

• DRAW a rectangle around your star. You can make a color cut [in the View menu]
if you cannot distinguish your star very well.

2For a divergent Moffat (b<1), the aperture was setted by experience comparing with the aperture
given by a Gaussian fit. Note that for the same PSF, the best aperture should depend on the S/N.
But it doesn’t in Abism so low S/N sources have a high uncertainty because the aperture may be “too”
large.

3in Strehl.py and in Appendix.
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• Et voilà ! It work ? If not, the software doesn’t know the parameters (Wavelength,
diameter...), give it in image parameters. Don’t forget to enter <Return> after
giving your numbers or to click on ImageParameters button once more.

1.2.2 What you can do
You can modify the way of measuring photometry, background, and the fit type. More
information is provided in Chapter

1.2.3 What you don’t have to do
As ABISM reads automatically the header, so you don’t have to enter the:

1. Wavelength [µm]

2. Diameter [m]

3. Central Obstruction [%](In % of size: for example a 1m m2 on a 10m m1 gives a
percentage of 10%. all previous parameters are employed in the diffraction pattern
calculation)

4. Pixel Scale [arcsec/pixel] (utilized to transform FWHM in arcsec)

Its are the only parameters to calculate the Strehl ratio, fortunately its are always in
the Header. If the image is not from ESO, you will have to enter it manualy clicking
on Image Parameters or permanently changing the Python module ReadHeader.py.
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Chapter 2

Install

2.1 Packages
The following python packages are necessary to run ABISM:
1 matplotlib for the image display and interaction
2 tkinter for the GUI
3 pyfits to open fits images, convert its to an array and a header
4 scipy for the bessel J1 function
5 pywcs to get the WCS projection from the header of the image

And you can install all following these commands for a rpm based Linux (Fedora):
yum install python-matplotlib
yum install tkinter
yum install python-matplotlib-tk # for matplotlib.backends.backend_tkagg
yum install pyfits
yum install scipy
yum install pywcs deb: apt-get install python-matplotlib

For a deb based Linux (Ubuntu):
apt-get install python-matplotlib
apt-get install python-tk
apt-get install python-pyfits
apt-get install python-scipy
apt-get install python-pywcs
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Chapter 3

Presentation

3.1 Modules
ABISM is called with the following command : “python Abism.py [image.fits]”.
Initially, the GUI was written in a single class called MyWindow. The independent
function were written in ImageFunction.py (this did not change). However the class,
written in a single text module became larger and larger: it was difficult to maintain.
The advantages of a class is that it shares its variables and function. Sharing all the
function resulted not so useful: each module import the module it needs and the in-
dependent functions are written in lower modules which can be called by every upper
module. Meanwhile, in one hand, the variables needed to be modified by the GUI and
read by the function and in the other hand, the output of the mathematical functions
needed to be displayed on the GUI.
The solution used to share the variables was to create two lowest modules: WorkVari-
able.py and GuiVariable.py. The modules of variables are empty. Every single module
which aims to communicate with the whole software will import the modules of vari-
ables and modify their variables. An example of such a process is given in Table 3.1.

The dependencies are presented in a diagram in Table 3.1. Note that there is no
plural in the name of the modules or functions.

• Abism.py just calls MyGui.py, it is to help the user to know how to call the
program.

• MyGui.py is the most important part of the code, it is the main caller. There
are some closed importation loops between for example MyGui.py and Pick.py,
this should be cancelled in the future. The only “necessary” importation loop
with MyGui.py is InitGui.py. Actually, in the futur, MyGui.py should be rename
EventGui.py or CallerGui.py and the function presents should just import some
other modules. In that way, ABISM will not need to import all the modules at
the beginning. This will permit ABISM to open faster and to consume less RAM.

• InitGui.py creates the GUI and modify its on demand when a button is creating
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“Gui.py”
import Var as V
import Function as F
from Tkinter import *
tk = Tk()
V.button = Button(tk,text=“Change color”,background=“red”,command=F.Command)
tk.mainloop()

“Function.py”
import Var as V
def Command():

if V.button[“bg”]==“blue”: V.Button[“bg”=“green”]
else : V.Button[“bg”=“blue”]

“Var.py”
#There is nothing written in this module

Table 3.1: Peace of code showing the way of sharing variables through the common
importation of an empty module. This is a work around to avoid writing all the GUI
in a single class.

a new frame (ex: “moreoption”).

• Pick.py defines the interaction between the user and the image (draw a rectan-
gle...). It calls EventArtist.py modules created to hide the heavy matplotlib event
handling classes.

• Strehl currently composed of 2 modules: a caller a a worker. These two modules
are gathering informations to estimate the Strehl (with some conditions) but never
work directly on the image array, that is why it is calling ImageFunction.py. It’s
result is directly displayed in AnswerReturn.py.

• ImageFunction.py is the first module I created, it aims to hide some heavy
calculation with lots of conditions. It may be decompose into several modules but
why.

• AnswerReturn.py updates the GUI and the terminal to display the outputs.

• HeaderRead.py reads the header to give some useful parameters. It is called
when an image is opened

• FitFunction.py performs a least square fit

9



MyGuiAbism

InitGui

Pick

EventArtist

ImageFunctionAnswerReturnHeaderRead

Strehl

↑
StatScaleBasicFunctionFitFunction

LeastSqBound

↑
GlobalDefiner

GuiVariable
as G

WorkVariable
as W

Table 3.2: Importation diagram of ABISM

• BasicFunction.py parametric function aimed to fit the date

• Scale.py To rescale the image (should be merged with Stat.py)

• Stat.py Some statistical functions on numpy array including a basic sky estima-
tion.

• GlobalDefiner.py Define the global variables reads sys.argv (the terminal input
line)

3.2 GUI
GUI stands for “Graphical User Interface”. ABISM is written in tkinter1, a python
library. Tkinter library calls Tcl-Tk2 which is currently present on all platforms (win-

1http://effbot.org/tkinterbook/tkinter-index.htm
2Tcl: Tool Command Language (http://www2.tcl.tk/445) is an interface, a common language created

in Berkeley University.
Tk: Tool Kit (http://www2.tcl.tk/477) is an implementation of the scripted interface permitting GUI.
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Figure 3.1: Screen shot of ABISM in October 2013: version 1.00

dows, Mac, Python).
Let’s describe ABISM GUI presents in Figure 3.2.

The GUI created by InitGui.py first packs the menu bar frame (MenuBar), then the
left frame (TextPaned) and the right frame (ImagePaned)3. The elements presents are:

1. Title bar with the title and the icon.

2. Menu bar with some cascade buttons. [G.MenuBar is a frame]

• File gives some info on the image.
• Help helps.

3I differ between a Frame and a Paned Window because a child is packed in a Frame and append in
a paned window, the paned window has sash so it can be resized.
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• Pick type chooses the way of picking objects.
• Scale Rescale the image, change its color.
• Fit type chooses the parametric function to fit.
• Appearance change the background of ABISM (foreground may be imple-

mented)

3. Button frame Some useful buttons, “ImageParameters” creates a frame with
entry for the user to fill the image parameters if not present in the header. Pushing
“entry” or cliking again on ImageParameters save the parameters. The necessary
parameters are [wavelength, diameter4, obstruction5, pixel scale].

4. More Options frame Some additional option for photometry and background
estimation. This new frame is created by Menu> more option.

5. Label frame Presents what ABISM learned with the header.

6. Answer frame Displays the results, Strehl.

7. Image frame Shows the image.

8. Toolbar frame Gathers some toolkits, x,y,z value of the image under the cursor
and z_max is the maximum value of z 10 pixels away from the pixel.

9. Fit paned window Some check plots to see if the fit is good. Also, these image
canvas can be used to show other thing (histogram, statistics....).

3.3 Usefull info
3.3.1 Preferences
Some parameters ( see in GlobalDefiner.TerminalVar() ) can be stored when pushing
the button reset. Then the resetting is calling ABISM with a certain command line dis-
played in the terminal. You have then two option, or you make an alias, utilising this
command line for abism or you write GlobalDefiner.PreferenceDefined and put their
your command line as a string variable called preference[“whatever”]. Also change in
the same module, the default variable of the function Preference: the line ’def Prefer-
ence(string=“whatever”)’ to call your preferences.

4in meter of primary mirror
5in area % of the secondary mirror on the primary
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Chapter 4

Use

1.2.2

4.1 Quick example
You have a fits image in the file : “image_folder/image.fits” and ABISM modules are
stored in abism_folder. The command:

python abism_folder/abism.py image_folder/image.fits

Will open ABISM GUI. If you cannot detect a star, the menu button “Scale” may
help. Draw with the left mouse button a rectangle around the star et voilà !
Note that the fit will be performed in the aperture you’ve just drawn so try to include
1/2 of noise and 1/2 of signal because both are fitted. You want more info ? Press Help-
>PythonConsole and type “print W.strehl” and then press run. It is ugly, I defined a
function called PD (Print Dictionary) so type “PD(W.strehl)” and then press run. The
sum is the photometry before the background subtraction.

4.2 Photometry and background
4.2.1 Mesure background
After multiple tests, it was noticed that the background estimation is the main source
of error, uncertainties. The background type variable is called W.type[“back”]. For
annulus and 8Rects background, the area where the sky is estimated is displayed in
the 2d shape figure. If you go to File -> MoreOption -> Background, you have some
different ways to estimate the background:

• Annulus: (default behaviour) is assessing the background in an elliptical annulus
of the same shape of the photometric ellipse and between axes of 1.3 and 1.6
times the axes of the photometric ellipse. A 3-sigma kappa clipping is performed
in the annulus area and the mean of the remaining pixels is the sky background
estimation.
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• Fit: It is assessing the background from the fit. It is though very dependant on
the size of the bow you draw around your star: if the background is varies a lot,
better draw a small box (if you checked this mode).

• 8Rects: It is drawing 8 small rectangles around the star and take the average
value of the photometry in these rectanges. This function was initially designed
to detect a non-homogeneous background comparing the small rectangles between
themselves.

• Manual and None: You can choose the background level, and None sets it to
zero.

4.2.2 Wiew: set color, stretch and cuts
Color: The color map can be changed with a click on the view menu button, nmore
color can be utilized with a cascade menu button (“More color”) button.
The shortcuts up and down arrow key can loop throw the (matplotlib) color map list
and left and right arrow keys invert the colors. The key shortcuts can only be used if
the cursor is on Abism GUI.

Stretch: The stretch, scale, can only be called in the menu button view.

Cut: The cuts can be chosen with an algorithm in the view menu button, manually
with the last menu button “Manual cut” of with the mouse on the color bar like for ds9
(Feature from DraggableColorbar.py). The algorithm are:

• percentage, the cut is performed to keep only a certain (99) percentage of the
pixels, excluding the brightest AND the faintest.

• RMS, Scale from -1 to 5 sigma around the median.

• None, scale from the faintest to the brightest pixel.

Contour: Instead of giving colors, only draw the contour of the objects. Contours
are drawn for 1 and 3 sigma higher than the median.

4.2.3 Measure photometry
The photometric type variable is called W.type[“phot”], change it in File -> MoreOption
-> Photometry.

• Elliptical Aperture: from the fit we determine the aperture to get 99% of the
flux of the parametric function. A basic sum is performed in this area.

• Fit: The photometry is performed from the fit. The theoretical integral of the
parametric function is computed (see Appendix).
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• Rectangle Aperture: Like the elliptical aperture but with a projection of the
major and minor axes on x and y axes to get a rectangular aperture.

• Manual: The photometry is performed in the box you’ve drawn. It is a basic
sum of all the pixels presents in the picking rectangle.

4.3 Constrain the fit
If you draw a rectangle (pick one), the fit will be performed in this rectangle. If you
choose binary fit, the fit will be performed in an aperture including both the binary
stars with 5 times their FWHM. The parametric functions are Gaussian, Moffat and
Bessel1. Also two Gaussians with the same center (Gaussian_hole) can mimic some
saturated stars but it not recommended to use this fit. It is possible to change the
parametric function in the Analysis menu button. In File -> More Option, one can also
get some check buttons which aims to constrain some parameters of the fits:

• Anisomorphisme: Fit a PSF with 2 major axes if checked and a circular
symmetric PSF if unchecked

• Binary_same_psf: Is only read out in case you are performing a binary fit.
IS constrains the PSF

Each pixel are considered with the same uncertainties. The uncertainty is the root
mean square of the image minus it median filter with a box of 3 × 3. Before the fit,
a supposed PSF center is estimated as the maximum of the median filtered subimage
selected (by the user drawn rectangle). This procedure permits to get read of the bad
pixels and also it is more accurate than an iterative gravity center which may fall in a
high noise level instead of on the true signal. Meanwhile, due to this estimation of the
maximum, it is impossible to get the SR with negative PSF. After having guessed the
center (and its intensity), the FWHM is quickly estimated by going down the PSF in
the four cardinal directions. An average of the 4 values is considered as the first guessed
FWHM. The supposed background is 0. The fit is performed with the python routine
scipy.optimize.leastsq() with some boundaries :

4.4 Error

Sr =
Ipsf
Idiff

dSr =
dIpsf
Idiff

+ Ipsf ×
dIdiff
−I2diff

=
1

Idiff
× (dIpsf + Sr dIdiff )

We change the - in + and in each term we take the absolute value because errors can
only be added (at least in our case [trust me]). The dIpsf is given by the error in the
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best fit square. It is actually well constrained (1,2 %). The main source of error is
dIdiff . As we said previously :

Idiff = bessel_integer × photometry (4.1)

So we need to calculate the error on the photometry :

dPhot = dBack ×
√
N (4.2)

Where dBack is the error on the background, the RMS and N is the number count, the
number of pixels in the aperture where the photometry were performed.
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Chapter 5

Develop ABISM

5.1 Add fit type
ABISM is most of the time fitting the PSF, you may want to had more parametric func-
tions. The fit type is stored in W.fit_type variable and mostly read by StrehlImage.py
module.

• ABIMS has:

• Gaussian

• Moffat

• Bessel

• Gaussian_hole (2 gaussians with same center for saturated stars

• ABISM misses:

• Cut fit with a threshold (for saturation)

• Bessel with central obstruction (same as the telescope)

The fit is performed by FitFunction.py calling leastsqbound.py1. If you want to add a
fit, you need to:

1The first written by Antoine Mérand aims to call easier the python function scipy.optimize.leastsq.
Some examples of fitting procedure are given at the end of FitFunction.py.
The second written by F. James and M. Winkler aims to bound the fit returning a junk function when
the parameters are out of the bound.
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1. Add a menu button in the GUI in InitGui.py in the function FitMenu: just add
in the list of fit types, a small list with two strings. The first string is the dis-
played value in the GUI (“My Fit”) and the second is value taken by W.type[“fit”]
variable when the user is pressing your new menu button (“my_fit_type”). It is
recommended to use the same string value my_fit_type as the parametric func-
tion you will define in BasicFunction.py module. In done so, you can call this
function with vars(BF)[W.type[“fit”]]. Otherwise, you will have to add condition
in AnswerReturn.py module which needs to call the parametric function in order
to display it.

2. Add a condition in StrehlImage.py: if W.type[“fit”]==“my_fit_type”. You then
need to determine the supposed parameters and you can constrain the parameters
with some boundaries. so call:

FitFunction.leastsqFit(BasicFunction.Moffat2pt,points,param,
image,err=err_image,doNotFit=doNotFit,bounds=James)

Where:

• image is a 2d array of the intensity in the region you want to fit
• err_image is a 2d array of the error in the region you want to fit
• doNotFit is a list of string of the parameters you don’t want to fit, because

you know they have the good value. For example if you want to fit a binary
star, you can fit the first one, assume it is good, and then fit the second one,
then assume the second is good, fit the first, iteratively instead of subtracting
the fit to the image (it is mathematically equivalent but cleaner).

• James is a dictionary with key some parameters and value a list of 2 values
: the lower bound and the upper bound (in this order).

You need also to determine the aperture of the ellipse in ImageFunction.py module
in EncircledEnergy. That is why it is recommended to use the same strings for
the parameters:

• center_x, center_y , spread_x, background, intensity
• spread_y , theta
• exponent

3. Add a parametric function in BasicFunction.py off the form:

def ParametricFunc(points,param) : return grid

Where points[0] and points[1] are arrays with the same shape as the image and con-
taining the index of the rows and columns respectively (created with np.meshgrid);
param is a dictionary countaining the parameters of the parametric function and
their value.
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5.2 Add pick type (matplotlib interaction)
The matplotlib (image) interaction type is stored in W.type[“pick”] and mostly read
by Pick.py module. Note that AnswerReturn module also reads it to anticipate which
parameters it will know.

• ABIMS has:

• Pick One (draw a rectangle)

• Pick Many (draw Many rectangle)

• Stat (draw a rectangle)

• Binary (Make 2 clicks)

• Profile (draw a line)

• Ellipse (an ellipse canvas is following the cursor using a blit mode to go faster )

• Annulus (an annulus canvas is following the cursor with blit)

• NoPick (To disable the matplotlib connections connection)

• ABISM misses:

• Custom selection (enable the creation of a custom polygon to get a customize
photometry for a very asymmetric PSF)

• Other event happening with some current selection method, for example pick
many objects and store them.

Note that the current conections event are really enougth for most of the work in
astronomy. One may better, change the way of working with the selected area rather
than changing way connections methods.

1. Add a GUI menu button including a string representing the label displayed on
the menu button (“My Pick”) in the list in ConnectMenu function in InitGui.py
module.

2. Add an element in RefreshPick list. Every pick button in the pick type menu
button is calling RefreshPisk function in Pick.py module with its label (the name
displayed on the button) as argument. In the list, add a sublist with: 1/The Label
displayed on the menu button (“My Pick”); 2/ The value W.pick_type will take
(“my_pick”); 3/ The Function to call (“MyPick”)
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3. Add a function in Pick.py module which will be called when the user click on
your menu button. This function must include a matplotlib connection when
the function is called with no argument and a disconnection when the func-
tion is called as MyPick(disconnect==True). See the other pick functions or
http://matplotlib.org/users/event_handling.html for more information on mat-
plotlib event connection. If the connection function is complicated, please store it
as a class in EventArtist.py as the function Profile().

5.3 Add instrument
The instruments classes are stored in ReadHeader.py. All these classes inherit from the
Header class. The Header class contains the __init__ function which is automatically
launch when the class is called: __init__ is the python name for the constructor
function. The function __init__ only call few functions which aims to store header
informations on class variables. W.head.header is the full header dictionary and the
header class is called W.head. For example the wavelength can be called in any module
as W.head.wavelength.
The instrument is read out by the function CallHeaderClass in ReadHeader.py module
as ’INSTRUM’, ’INSTRUME’ or ’INSTRUMENT’ key.
So to add an instrument:

• Make a condition in the CallHeaderClass function (basically to call your class
when you want): “if ’my_instru_string’ in instru : W.head = MyInstru(header)”
where my_instru_string is string contained in the INSTRUMENT keyword and
MyInstu() is the class you will generate; finally, instru, W.head and header are
variables I defined before, just call its like that.

• Create a class inheriting from Header class :“class MyInstru(Header)” and define
the variables you want in its. There are several functions called by __init__
(i. e., when calling your class). Note that you if a function is missing in your
class, the function with the same name will be called in its parent class: Header.
Therefore, you don’t need to create all of these functions if you don’t want to
modify the the header reading default of the corresponding keys. Let’s enumerate
the called functions, if its are marked with a “*”, this means that you should
create a function with such a name to create your instrument specific variables.

1. InitKey: To create the defaults keys, in case some keys are not defined [you
should not create such a function and rely on the inherited function I created
]

2. StrehlKey*: To define the necessary variables to determine a Strehl
– self.wavelength
– self.diameter
– self.obstruction
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– self.pixel_scale
If you create a function called StrehlKey, make sure you defined all these
variables and that they are floats.

3. ObservationKey*: To know some conditions of observation, telescope, inst,
ESO. It is a good check to know what your header reading performed.

4. WCSKey: To know the WCS projection [ if you’re using reduced image, I
advice you create such a function ]

5. MoreKey: To put
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Appendix A

Ellipse drawing

A.1 Rotate referential, coordinates behave the opposite
way as vectors

An intuitive example is scaling : if you increase the size of the base vector, for the same
point, you need to decrease the coordinate.

We consider a orthonormal referential with base vector (U⃗ , V⃗ ) rotated by θ from the
base (X⃗, Y⃗ ) like Figure A.1.

Figure A.1: Rotation of a
2D base of vectors.

We define the rotational matrix:(
U⃗

V⃗

)
=

[
Cos(θ) Sin(θ)
−Sin(θ) Cos(θ)

](
X⃗

Y⃗

)
But coordinates behave in the opposite way:(

u v
)
=
(
x y

) [ Cos(θ) Sin(θ)
−Sin(θ) Cos(θ)

]
That can be written as :(
u
v

)
=

[
Cos(θ) −Sin(θ)
Sin(θ) Cos(θ)

](
x
y

)

Why ?
If:

⃗V ec = (x, y)

(
X⃗

Y⃗

)
= (u, v)

(
U⃗

V⃗

)
(A.1)

And: (
U⃗

V⃗

)
= M

(
X⃗

Y⃗

)
(A.2)
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So:

(u, v)×M

(
X⃗

Y⃗

)
= (x, y)×

(
X⃗

Y⃗

)
(A.3)

And by identification (u, v) = (x, y)M or
(

u
v

)
= M−1

(
x
y

)

A.2 Ellipse equation
We have an ellipse of axes (ru,rv) along (U⃗ , V⃗ ) vectors and centred on (0,0).(

u
ru

)2
+
(

v
rv

)2
=

(
xCos(θ)−ySin(θ)

ru

)2
+
(
xSin(θ)+yCos(θ)

rv

)2

=

x2
((

Cos(θ)
ru

)2
+
(
Sin(θ)
rv

)2)
+y2

((
Sin(θ)
ru

)2
+
(
Cos(θ)

rv

)2)
+x× y

(
Sin(2θ)(1/rv2 − 1/ru2)

)
(A.4)
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Appendix B

Encircled

B.1 The PSFs

We forget the two useless parameters x0 and y0 and consider the PSF to be centred on
0.

B.1.1 Gaussian

PSF (I, α) = I × e(R/α)2

B.1.2 Moffat

PSF (I, α, b) = I ×
(
1 +

R2

α2

)−b

B.1.3 Encircled Energy

We integer a typical PSF up to radius R. How much flux do we have. We also add, I
and α, some standard scale parameters such as PSFscaled = I ∗PSF (R/α). α has units
of pixels and I of flux.
Now if we want ϵ% of the flux, up to which R (R/α), do we need to integrate the PSF.

B.1.4 Changing Variable

In the next section we will calculate the integral of PSF (I, α...) wich can be related to
the integral of PSF (I, 1...) (considering α = 1 is easier).
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PSF (I, α...) = 2π ×
∫

f
( r
α

)
rdr

= 2π ×
∫

f (u) (u× α)(du× α)

= α2 × 2π ×
∫

f (u)udu

= α2 × PSF (I, 1...)

WARNING, this is an obvious situation, but you have 2 things to remember :

• Multiply by α2 (as described above)

• Integrate up to R/α (and not up to R any more because this R you calculated
before was calculated for a α = 1, So to be at the “same” place on the PSF, scale
also the cuts)

We utilised

u = r/α

du = dr/α

B.2 Gaussian
B.2.1 FWHM

e−
FWHM2

α2 =
1

2
FWHM2

α2
= ln(2)

FWHM =
√

ln(2)× α

B.2.2 Encircled Energy

2π

∫ R

0
e−r2r dr = 2π[

e−r2

−2
]R0

= π(1− e−R2
)

=⇒ 2π

∫ R

0
e−(r/α)2r dr = I × α2 × π(1− e−R2/α2

)

lim
R→+∞

Iα2π

Note that we integrate up to R and not up to R/α. The factor α2, comes from a
change of units and the term α in the exponential comes from the fact that the PSF is
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different.

The percentage ϵ can be calculated : A = ϵ× Total energy, considering I=α=1, (I
has no influence, R is prop to α).

π(1− e−R2
) = A

e−R2
= 1− A

π

R =

√
−ln(1− A

π
)

R =

√
−ln

(
1− ϵπ

π

)
=⇒ R = α

√
−ln(1− ϵ)

B.2.3 2d Integral

2π ×
∫ ∞

0
e−r2rdr

= 2π ×

[
e−r2

−2

]∞
0

= 2π ×
[
0− 1

−2

]
= π∫

2d
I × e−x2/α2

= Iα2π

B.3 Moffat

B.3.1 FWHM

(
1 +

FWHM2

α2

)−b

=
1

2

FWHM2

α2
=

(
1

2

)−1/b

− 1

FWHM = α×

√(
1

2

)−1/b

− 1
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B.3.2 Encircled Energy

2π ×
∫ R

0

(
1 + r2

)−b
rdr = 2π ×

[
(1 + r2)−b+1

2(−b+ 1)

]R
0

=
π

b− 1

(
1− (1 +R2)−b+1

)
=⇒ 2π ×

∫ R

0
I
(
1 + (r/α)2

)−b
rdr =

Iα2π

b− 1

(
1− (1 + (R/α)2)−b+1

)
lim

R→+∞

Iα2π

b− 1

The percentage (A = pi
b−1 × ϵ: α and I wound vanish on the first line) of encircled

energy over the total energy :

π

b− 1

(
1− (1 +R2)−b+1

)
= A(

1− (1 +R2)−b+1
)
= A

b− 1

π

(1 +R2) =

(
1−A

b− 1

π

)1/(1−b)

R =

√(
1−A

b− 1

π

)1/(1−b)

− 1

=⇒ R = α

√
(1− ϵ)1/(1−b) − 1

B.3.3 2d integral

2π ×
∫ ∞

0

(
1 + r2

)−b
rdr

= 2π ×
[
(1 + r2)−b+1

2(−b+ 1)

]∞
0

= 2π ×
[
0− 1

2(−b+ 1)

]
=

π

b− 1∫
2d
I × [1 + x2/α2]−b =

π × Iα2

b− 1

B.4 Bessel
B.4.1 FWHM

FHWM = 1.028λ/D (B.1)
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B.4.2 2d integral
∫
2d

(
2J1(x)

x

)2

= 2π

∫ ∞

0
4
J1(r)

2

r2
r × dr

= 8π/2 = 4π

Because : ∫ i

0
nfty

Jν(t)

dt
=

1

2ν
(B.2)

B.5 Bessel with obstruction (ϵ)
2d integral
The fourier transform of an circular aperture with a pourcentage of central obstruction
ϵ is :

I(u) =
1

(1− ϵ2)2

[
2J1(u)

u
− ϵ2

2J1(ϵu)

ϵu

]2
(B.3)

With u = πDθ
λ

I(u) =
4

(1− ϵ2)2

[(
J1(u)

u

)2

− 2ϵ2
(
J1(ϵu)× J1(u)

ϵu2

)
+ ϵ4

(
J1(ϵu)

ϵu

)2
]

∫
2d
I(u) =

4

(1− ϵ2)2

[
π − 2ϵ× (πϵ) + ϵ4 × π

ϵ2

]
∫
2d
I(u) =

4π

(1− ϵ2)2
[
1− ϵ2

]
∫
2d
I(u) =

4π

1− ϵ2

We could have found it noticing that with a central apertur, the flux will decrease like
1− ϵ2 but the central intensity will decrease like (1− ϵ2)2. So :

Imax∫
I(u)du

=
1− ϵ2

4π
(B.4)

Now we have to change variable u to be able to integrate over the pixels. We can do
that in 2 steps : from u to θ and from θ to pixels. We have :

θ

u
=

λ

πD
Pixel

θ
= 1/FPS

Pixel

u
=

λ

πD × FPS
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99.9% 99.5% 99% 95% 90% 50%
Gaussian 2.63 2.30 2.15 1.73 1.52 0.83

Moffat (b=1.5) 999 199 100 20 10 1.75
Moffat (b=2) 31 14. 10 4.35 3. 1.

Where FPS = Focal Plane Scale and is proportional to the inverse of the telescope focal
lenght. And then :∫

2d
I(u)dpixel =

(
λ

FPSπD

)2 ∫
2d
I(u)du∫

2d
I(u)dpixel =

(
λ

FPSπD

)2

× 4π

1− ϵ2
× Imax

We know the integral, we will find Imax to calculate the strehl.

B.6 Numerical Results
So, if you want percent % of the flux, how far must you go ? The results are given in
units of α, link α to the FWHM with Section ??.

bad for moffat
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